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Windows Server 2012 R2 64-bit

View Connection Server !, solatw! JB sla fole piwaw V=Y Jga

Uelpg A Jole picn
Standard Cow 64 Windows Server 2008 R2 SP1
Enterprise
Datacenter
Standard Coo 64 Windows Server 2012 R2
Datacenter

View Administrator
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Internet Explorer 9 (not recommended)

Internet Explorer 10

Internet Explorer 11
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Firefox (latest supported versions)

Chrome (latest supported versions)

Safari 6 and later releases
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$95 5 1y slme legliSiws View Composer .o ls oage |, SliSws ol g cilo ailsy jiso oyl
s (53 2 s (BB L g aiSie oloul il o IMAGE S & g0 4 a5 Jole piaws slo auis
ool oo s FY sl fele

s VCBNtEr ;o olil 4y Jg 90,5 caai lizme (550 59, 2 b 9 VCBNTET 55,0 (55, Wil o 1381 05 0]
sl ansls View Composer G ol

View Composer /38! cow slajls i V-F Joox
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e b eo ol QLSws B (g5l
60GB 40GB Sass glas

View Composer sasms Sloiis slo Jale giasw V-0 Jso

g Ao Jols i
Standard Con 64 Windows Server 2008 R2 SP1
Enterprise
Datacenter
Standard Coo 64 Windows Server 2012 R2
Datacenter

Events Database , View Composer !, solizwl LB slDatabase Servers :\-# Jooo

ol

Service Packs/Releases
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Microsoft SQL Server 2014 Standard
No SP, SP1
(32- and 64-bit) Enterprise
Express
Microsoft SQL Server 2012
SP1, SP2 Standard
(32- and 64-bit)
Enterprise
Express
Microsoft SQL Server 2008 R2 Standard
SP2, SP3
(32- and 64-bit) Enterprise
Datacenter
Express
Microsoft SQL Server 2008
SP4 Standard
(32- and 64-bit)
Enterprise

Standard One

Oracle 12¢ Release 1 (any release up to 12.1.0.2) Standard
Enterprise
Standard One

Oracle 11g

Release 2 (11.2.0.4) Standard

(32- and 64-bit)

Enterprise
View Agent

Samme VIEW CONNECLION 5 I8 0 bLS )| Jule View Agent .ol oo )5 oS Cos L1580 015
cwai e RDS HOSt 5 S0 58 (slpaiinns «55lme slo uislo asm (55, » b View Agent oo 5

D9

21y G558 8550 GLSws wugn Sl 5l a5 0ad oy oy 4 Wl oo 3l 55, 5 ST L LS )8
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Ol Jols pruw A o9 S gmg
\Windows 10 64-bit & 32-bit  [Enterprise None
Windows 8.1 64-bit & 32-bit  |Enterprise & Professional Latest update
\Windows 8 64-bit & 32-bit  |Enterprise & Professional None
\Windows 7 64-bit & 32-bit  |Enterprise & Professional SP1
\Windows Server 2012 R2 64-bit Datacenter None
\Windows Server 2008 R2 64-bit Datacenter SP1

View Agent gl oo Slociin oS ed sl Jole piew :V-A Jou

o 398 s
Ubuntu 14.04 X64
Ubuntu 12.04 X64
RHEL 7.1 X64
RHEL 6.6 x86 & x64
CentOS 6.6 X64
NeoKylin 6 Update 1 X64

vSphere platform |vSphere 5.5 U3, vSphere 6.2 U1, or a later release
\version
vSphere 6.2 or a later release is required to support NeoKylin.

vSphere 6.2 U1 or a later release is required to support virtual machines with 3D
graphics, including NVIDIA GRID vGPU, vDGA, and VSGA.

Horizon Horizon 6 version 6.2.1 or a later release
environment

Horizon Client Horizon Client 3.5.2 for Windows, 3.5.0 for Linux, or 3.5.2 for Mac OS X
software

Zero clients and mobile clients are not supported

ZL;[@L.J)‘ JS-'B)J
ol Jl gl wb sl (molS Cyz )0 0uls gy S5, PCOIP (PC over IP) LLs )l ISy,
JSJS).’ u.s‘ 6L® k.a.a.l)lﬁ o) salau! JJ[SWAN 9 LAN J.a.w.’ SS9y 2 as ».\.ml.a LSA)Jj.«a.’ 9 lowo cd.ol.;).j
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O s Sl 5 (558 iy Ojg0 4 AES 128 (65550, JSGg 5 5l ealitul -
View Agent s b 5l lo GliSws Jule pitaaw b bLs )| -

CaMS oKiws g9, 31 bl 6,8, culld -

WAN; LAN (55, b pae b sligy talS -

S VY aled azmio 5l (Slosids -

149.«4.: 9 lowo g_i;)é < ,L:L..;)‘-

297 9 S o SleMbl 038 (oS (Bl -

Lo &0 59, »» USB Redirection Sl -
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: Active Directory as o
13,5 (gai S 1) (6,58 ploguST cuwl o HOTiZON o ) 2
ols & View Connection g, 9,5 Join .
OUq ] S g abogr o GPO sl 4 remote desktops !, OU G slss! Y
kiosk ,s ,,I5" kiosk mode client) !, 05,5 s OU G sl thin client sl eolacsl &0 0 ¥
S g9,00 9 View Connection b bLs | ey thin client G 5l as” el 5,5 mode
(.2,5 o 0,40 Femote desktop session
View group )l olgsds ol as 09,5 G )yl calizes glgil g1y o 09,5 sl! f
VieW alie aels jo b 55 0,5 cpfvCenter ) LIS sl cuels 5o 60,8 ob G olw! .0
(2l asls Composer 3 VCENTEr ,g,w (5, » oyl o yiws 5 2L Connection
View alie aels ;o b 55 5,5 cpl) Iize View COMPOSer ;5w sly 5,5 sl £
(sl axsls View Composer (,.ile 54, local admin . w4 035 Connection
D oo Sgaze QrOUp policy ol VY
b gae local remote desktops og,5 ;0 Wb oyl 4,5« remote desktop Lbs | ey
2 e 3l g 03903 5L 1, group policy el . remote desktop cuys 05,5 S5 slu! (sl
e sl 1) ]

Computer Configuration =>Windows setting = Security setting =>right click on
Restricted Group = Add Group ->Add a remote desktop user group > Ok

: View Composer .as
I, View COMPOSEN s g s 3505 Sl el G Casl oo View Composer ;| sola! sl

0,5 (634,50 5 e

tommlin s ol
View Lwg a5 Sledbl .asl asls |18 ass ;o b g asb local & g0 4 Wl co ulos
el 518 ol 4 058 o Cud unlins (g3, »» COMpOser

vCenter g, Slbls )l -

Active Directory «lbls,l-

3l oo ol | View Composer Lwgs a5 e Linked-clone desktops -

3l sals oloy! View Composer bwgs a5 slo S -
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share .olos 5l asly e b View Composer 3 el ls 1) 543 o5 uslus View Composer ,»

AsS eolaw!

:SQL 9, 59, » View Composer sl p olos olsw! J> e

File Edit Wiew Debug Tools Window Help
- -5 | A NewQuey [ iR R | 4 @]9 - - E-5 g b

Object Explorer

* 0 X

Connect~ 3 34 T 2] "

= [y SOL (SOL Server 11.0.5058 -

o] Database:

[ Security

3 Server Ob
[ Replicatic
[ AlwaysOr
[ Managerr
[ Integratic
[ S0L Serve

MNew Database...

SQLng) » u,w.:L.:é OL?U‘ (\

Microsoft SOL Server Management Studio (Administrator)

Attach...
Restore Database...

Restore Files and Filegroups...

Deploy Data-tier Application...
Import Data-tier Application...

Start PowerShell

Reports

Refresh
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g New Database = |0 -
Selecta page I . =
) 5 - Hel
2 General ‘;S = Lj ?
25 Options
;2‘“ Filegroups Database name: |‘u"|ewCornposer |
Owner: <defaut> |[]
Database files:
Logical Name File Type  Filegroup Initial Size (MB)  Autogrowth / Maxsize
ViewComposer  Rows .. PRIMARY By 1 MBE, Unlimited
ViewCompaos... Not Applicable 1 By 10 percent, Unlimited
Object Explorer » 1 X

Connect~ 3 & m “F & "

¥ [ Databases
= [ Security
=] Logins
+ [ Server
¥ [ Crede
[ Crypte
¥ [ Audits
+ [ Server
+ [ Server Ob
[ Replicatio

F

+

+

[ Management

+

+

= [ SOL (SOL Server 11.0.5038 -

[ Always0On High Availabi

[ Integration Services Cate
+ ﬁ% SCL Server Agent

Mew Login...

Filter »
Start PowerShell
Reports »
Refresh
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Selecta page
% General
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28 Seript = [ Help

18 Server Foles
% User Mapping
% Securables

[ Status

Connechion

Server:
SaL

Connection:

;’j Wiew connection properties

Progress

Login name: |Cnn1pnser

() Windows authentication

(® S0L Server authertication

Password: |i--o----

Confirm password:

|| Specity old passwaord

EHlremmik [
L

[] Enforce passwaord policy

|| Enforce password expiration
[] User must change password at next login

() Mapped to cerificate |

() Mapped to asymmetric key |

[] Map to Credential |

Mapped Credertials

Default database:

Default language: <default>
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Connection

Server:
saL

Connection:

3 View connection properties

Progress
Ready

VMware Horizon View 6.2 b @lSws g jlw 5 jkxo 59 945 &> w0

5 Seript = [ Help

Server role is used to grant server-wide security privileges to a user.

Server roles:

[] bulkadmin

[] dbcreator

[ diskadmin

[] processadmin

[v] public:

[] securityadmin

[] serveradmin

[ setupadmin
sysadmin
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| B S st ~ [Hep
|2 Server Roles
j |User Mapping lsers mapped to this login:
2 Securables Map Database Default Schema
A Status Event\View

master
model
medh
tempdb
{ ViewComposer

[] Guest account enabled for: ViewComposer

Database role membership for: ViewComposer

[] db_accessadmin
Server: [] db_backupoperator
saL [] db_datareader
Connection: [] db_datawriter
[] db_ddladmin
db_d ataread
Liﬂ View connection properties Edb:dmatzmerer
@dowrer
Progress [] db_securityadmin
[] public

Connection

View Composer ,g,. 55, » ODBC Connection < sl! (Y

Start > Administrative Tools - Data source (ODBC) - System DSN Tab > Add ->SQL
Native client > Finish
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Home

Shortcut Tools l Application Tools

View Manage Manage

VMware Horizon View 6.2 b @lSws g jlw 5 jkxo 59 945 &> w0

v @

1 |;ﬁ] <« All Control Panel ltems » Administrative Tools »

] 0| | Search Administrative Tools

? ]

1'.\{ Favorites
B Desktop

j Downloads
“El Recent places

18 This PC

f! Network

FS
Narne

. Terminal Services

@- Compeonent Services

@ Computer Management

E‘} Defragment and Optimize Drives
Disk Cleanup

|ﬁ Embedded Lockdown Manager
@ Event Viewer

fak, i5CS! Initiator

E:‘g Local Security Policy

[#F Microsoft Azure Services

ODEBC Data Sources (32-bit)

Date medified

8/22/2013 8:09 PM

8/22/201311:27 AM
8/22/201311:24 AM
8/22/201311:17 AM
8/22/201311:27 AM
11/22/2014 7:30 AM
8/22/201311:25 AM
8/22/201311:27 AM
8/22/201311:24 AM
11/22/2014 5:16 AM
8/22/2013 4:26 AM

Type
File folder
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut

Size

ODEC Data Sources (64-bit)

8/22/2013 11:29 AM

Shortcut

@ Performance Monitor

A/22/2013 11:22 AN

Shortcyt

@ Resource Monitor

|§g Security Configuration Wizard
(@ Server Manager

@ Services

(7 System Configuration

(& System Information
@ Task Scheduler

@ Windows Firewall with Advanced Security

26items 1 item selected 1.11 KB

8/22/2013 11:15 AM
8/22/2013 11:25 AM
8/22/2013 11:24 AM
8/22/201311:23 AM
8/22/2013 11:23 AM
8/22/2013 11:25 AM
8/22/2013 11:15 AM

| Maintains ODBC data sources and drivers, "

Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut
Shortcut

User DSN | System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Mame Platform  Driver

Remove

Configure...

An QDBC System data source stores information about how to connect to the indicated data provider.
A System data source ig visible to all users on this machine, including NT services.
0
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= ODEBC Data Source Administrator (64-bit)

User DSN | System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Mame Platform  Driver

Create New Data Source

Select a driver for which you want to set up a data source.

Mame Version Comj

| SQL Server 6.03.9600.17415  Micn
GER SQL Server Mative Client 11.0 RaU NIRRT

L e

i indicated data provider.
ViCes.

—>In the Create a New Data Source to SQL Server setup wizard Type name: View
Composer
—>In the Server text box Type SQL Server DB name: Sqgl Server FQDN - Next
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This wizard will help you create an ODBC data source that you can use to connect to
SQL Server.

What name do you want to use to referto the data source?

Name: |‘u"|ewCumpnser

How do you want to describe the data source?
Description: |

Which SQL Server do you want to connect to?
Server: |SQL TechNet24Jocal

How should SQL Server verify the authenticity of the login D7

)

Cr,
ﬂSErverzmz

() With Intearated Windows authentication.

5PN [Dptional): |

® With SQL Server authentication using a login 10 and password entered by the
user.

Login 1D: |Ccmposer

Fasword:|uuuu

15,5 o sl Authentication g, e

T an s
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Integrate Windows authentication

2k Remote & ye0 4 SQL g, a5 550 40

SQL Server authentication

Next - Change the default database to > Type Name: View Composer > Finish

[#] Change the default database to:

ﬁ |‘u'iewCornposer

=
$OL server 2012 Mirror server:

SPM for mimor server (Optional):

[] Attach database filename:

[#] Use ANSI quoted idertifiers.

Application intent:

[#] Use ANSI nulls, paddings and wamings.

|READWRITE

[ Muttisubnet failover.

<Back |

[]Change the language of SOL Server system messages to:

| English

[ ] Use strong encryption for data

[wf] Perform translation for character data
[ ] Use regional settings when outputting cumency, numbers, dates and times.

["] 5ave long running queries to the log file:

|C:\Users\ADMINI~1\AppData\Local' Temp\QUERY| Browse...

Long query time (miliseconds): |3|}DDD
[]Log ODBC driver statistics to the log file:

|C:\Users\ADMINI~1\AppData\Local\ Temp\STATS |

<Back ||

Finish
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A new ODBC data source will be created with the following configuration:

Microgoft SQL Server Mative Client Version 11.00.5058

Data Source MName: ViewComposer
Data Source Descriction:

Server: 3ql technet?4 local

Use Integrated Security: Mo

Database: ViewComposer

Language: (Default)

Data Encryption: Mo

Trust Server Cerificate: No

Multiple Active Result Sets(MARS): No
Mirror Server:

Translate Character Data: Yes

Log Long Running Gueres: No

Log Driver Statistics: No

Use Regional Settings: Mo

Use AMNS| Quoted ldentfiers: Yes

Use ANSI Mull, Paddings and Wamings: Yes

|| ok || Cancel

Test Results

Microsoft SQL Server Mative Client Version 11.00.5058
Running connectivity tests. ..

Attempting connection

Connection established

Werifying option settings

Digconnecting from server

TESTS COMPLETED SUCCESSFULLY!

: View COMpPOoSer g w oo
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22 L alo bl 50,5 cuai lize & ygo as b g VCBNET 5000 (55, 2 olg (o 1, ViEW COMPOSEr g s
5970 VIEW COMPOSEr i (512 (peizpod 3565 )18 s 2 (595 5,500 VIBW 381 6

Ll ol Administrator

Right click the Installer File > Run as administrator - Accept license and change
destination folder - Type the DSN for SQL

D VMware Horizon™6

) Composer

VYMware Horlzon™6

Composer

EIPCalE

Viware Horizon 6 Composer -

Welcome to the Installation Wizard for
VMware Horizon 6 Composer

The installation wizard will install VMware Horizon & Composer
on your computer. To continue, didk Mext,

Copyright © 1998-2015 VMware, Inc. All rights reserved. This
product is protected by U.5. and international copyright and
intellectual property laws, YMware products are covered by
one or more patents listed at

http: ffwww . vmware.com/go/patents.

< Back | Mext = | | Cancel
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il VMware Horizon 6 Composer

License Agreement

Flease read the following license agreement carefully.

VMWARE END USER LICENSE AGREEMENT ~

PLEASE NOTE THAT THE TERMS OF THIS END USER
LICENSE AGREEMENT SHALL GOVERN YOUR USE OF
THE SOFTWARE, REGARDLESS OF ANY TERMS THAT
MAY APPEAR DURING THE INSTALLATION OF THE
SOFTWARE.

(%) [ accept the terms in the license agreement

() I do not accept the termz in the license agreement

Installshield

| < Back ” Mext = | | Cancel |

e )5 jeae 50y 9 6,505 o9 o ls > Create Default SSL certificate = Install = Finish

il VMware Harizon & Compaoser
Database Information

Enter additional database configuration information.

Enter the Data Source Name (DSM) for the YMware Horizon 6 Composer database. To setup
the DSM dick the ODEC Setup button,

|'L"iE'.n\'CDI‘I‘|pDSEF ODEC DSM Setup...

Enter the username that you entered in the ODBC Data Source Administrator,

|C|:nm|:u:|ser

Enter the password for this database connection.

InstallShield

< Back | | Mext = | | Cancel
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VMware Horizon & Composer Port Settings
Enter the connection information for the YMware Horizon & Composer,

Spedfy the web access port and security settings for YMware Horizon & Composer,

SOAP Port: 18443

S5L Certificate: Mo S5L certificates were found on your machine.,
A default 55L certificate will be created for you.

Installshield

Ready to Install the Program

The wizard is ready to begin installation.

ViMware Horizon & Composer will be installed in:
C:'Program Files (x3&)\WMware\WMware View Composer,

If you want to review or change any of your installation settings, did: Badk, Click Install to
beqin the installation or Cancel to exit the wizard.

Installshield
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i VMware Horizon 6 Composer -

Installer Completed

The installer has successfully installed YMware Horizon &
Compaoser, Click Finish to exit the wizard.

VMware Horlzon™6&

Composer

EIPCol

< Back Cancel
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Pow g

Event View (1, seoloo sl - View Connection Server coai g sslo pj olenass
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: View Connection s, oslo p) oledas

13,5 axg5 5 OlS 4 b View Composer ;l oslai! sl »
s VCENLEr o 1 LT wledbl wls (gjlme sl DleMbol a5 bgypo ;0038 g s Sl 5l o ™
oo oolaiwl adgl wledbl s 5l View administrator Jg. S 5l cewl oo ol gl a5 0l

.>9~.,

A S5 6l Dyee Ly o}lxlgwbwom 2ol cwla (55, a5 sl g3l Tgw "

ik ansly 5929 RAM g CPU o> ol 55lxe slo cpiile ol oL ™
solitul L5 ks A iSTas 00,5 (o 0olii] ;2SS 55, 52 VMFSS 1 5 asd slo aseus 51 ®

: View Connection Server |58l s 5 Coas

"Security ;" Replica" . "View Connection" g0 4w 4 oy - 1,View Connection

3,5 ool 8 lasbiw] (og, 5l b adgl cuas slp ges cuas SErVET™

slw! View LDAP wo> Sleodas L View Connection g, 5l sl ages
&S s

View Connection c.as

View LDAP oledas (0,5 oS L View Connection g, 5l sl diges

Replica cea

A e el @Bl Y ol! sl » View Connection g, 5l sl aiges
ICL PR E ) USR] I ESY

Security Server .

00,5 bl 55 slasls i b View Connection coas 51 oo

b opals gac b View Connection g w0 -

Jio 6,58 g 2o pizen oL Domain controller o,Ls View Connection g, -

ik ol cuas 1 59, Remote Terminal L 4 vCenter

Sges osliiwl pae 55 5l el o View Connection cuas sl -

3,5 18 oilme b (Sopd il SO (53, (5,500 VIBW 1581 0 5 m L wilgs o3 View Connection -
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: View Connection ceas J>! 0

S UL 90 VMware-ViewConnectionServer-x86_64-6.2.0-XXXXXXX.EXE (g,

|E:(“=|

Application Tools VMware Horizon View

Home Share View Manage v 0

v: B ‘ . « VMware Horizon 6.2 » VMware Horizon View v ¢ ‘ j Search VMware Horizon View @ ‘

¢ Favorites

B Desktop
& Downloads

| Recent places

1M This PC

“! Network

13 items

<]
1item selected 179 MB

- Date modified Type S
Text Document
Compressed (zipp...
Compressed (zipp...
Application
Application

Application

VMware Horizon™6 Application

I Connection Server Applision
GZ File
GZ File

Application

Application

Application

VMware Product Installation

.:,'i Preparing VMware Horizon 6 Connection Server' for installation...
£,




Goxoils ol wiigo VMware Horizon View 6.2 b @lSws g jlw 5 jkxo 59 945 &> w0

i Viware Horizon & Connection Server -

Welcome to the Installation Wizard for
VMware Horizon 6 Connection Server

The installation wizard will install VMware Horizon & Connection
Server on your computer, To continue, didk Mext.

VMware Horlzon™6

. Copyright (c) 1998-2015 YMware, Inc. All rights reserved. This
Connection product is protected by U.5. and international copyright and
Server intellectual property laws. YMware products are covered by
one or more patents listed at

http: {fwww. vmware.com/go/patents.

Product version: 6,2.0-3005368 x64 <Back | MNext> || Cancel |

sy |y, Next g oo 5 Gl |, Accept a5

License Agreement
Please read the following license agreement carefully.

VMWARE END USER LICENSE AGREEMENT A

PLEASE NOTE THAT THE TERMS OF THIS END USER LICENSE AGREEMENT SHALL
GOVERN YOUR USE OF THE SOFTWARE, REGARDLESS OF ANY TERMS THAT MAY
APPEAR DURING THE INSTALLATION OF THE SOFTWARE.

IMPORTANT-READ CAREFULLY: BY DOWNLOADING, INSTALLING, OR USING
THE SOFTWARE, YOU (THE INDIVIDUAL OR LEGAL ENTITY) AGREE TO BE

BOUND BY THE TERMS OF THIS END USER LICENSE AGREEMENT ("EULA"). IF
VLI NO NAT ARREE TN THE TERMQ NE THIQ E1IE A4 VI L MIIQT NAT

(®) 1 accept the terms in the license agreement
() 1 do not accept the terms in the license agreement

S ST NEXE (55, 5 05,5 oy yesd o |) el (5,8 iy e
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Destination Folder
Click Next to install to this folder, or dick Change to install to a different folder.

Install VMware Horizon View Connection Server to:
C:\Program Files\VMware\VMware View\Server\

2 903,5 bl |, View Standard Server au ;3 ol asis o Connection Server oas (gl ool a8 ol
QS s Next (g,

Installation Options
Select the type of Horizon & Connection Server instance you want to install.

Select the type of Horizon & Connection Server instance you want to install.

Horizon & Replica Server [+ Install HTML Access
Horizon & Security Server

Perform a standard full install. This is used to install a standalone instance of Horizon &
Connection Server or the first instance of a group of servers.

Spedfy what IP protocol version shall be used to configure this Horizon & Connection Server
instance:

This server will be configured to choose the IPv4
protocol for establishing all connections.

IPvd

..\.o.-Ss.i:.lSNext ‘55)).35».\.;.15-5)5 0)5.»...0&5;4.19,0 Q.ﬂ)»)
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Data Recovery
Enter data recovery password details.

This password protects data badkups of your Horizon 6 Connection Server, Recovering a backup
will require entry of this password.

Enter data recovery password: " [ —

Re-enter password: || snaanuny

Enter password reminder {optional):

Automatically configure the Windows Firewall to allow incoming TCP protocol
connections.

In order for View Connection Server to operate on a network, spedfic incoming TCP ports
must be allowed through the local Windows Firewall service. The incoming TCP ports for
the Standard Server are 8009 (AJP13), 80 (HTTP), 443 (HTTPS), 4001 (OMS), 4100
(IMSIR), 4172 (PColP), 8472 (Inter-pod API), and 8443 (HTML Access). UDP packets on
port 4172 (PColP) are allowed through as well.

(®) Configure Windows Firewall automatically
O Do not configure Windows Firewal
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JouS 4 o yiws (TECHNET24\administrator Jlo (lgic 40) AD 1,5 L go0g,5 4z a5 auS  adeiue
VLY x_i:.lSNeXtL_gs) R AS)L) ‘) View

Initial Horizon 6 View Administrators

Specify the domain user or group for initial Horizon & administration.

To login to Horizon & Administrator, you will need to be authorized. Select the local
Administrators group option or enter the name of a domain user or group that will be initially
allowed to login and will be granted full admistrative rights.

The list of authorized administrator users and groups can be changed later in Horizon &
Administrator.

() Authorize the local Administrators group

(®) authorize a spedfic domain user or domain group

ITECHNI:—I'24‘|,administrabar

(domainname\username, domainname\groupname ar LUPN format)

Next (gg, dalol gl 0SS Jbd |y a3l 13 STsl o VMware L ) s ools auales oo Lol |51

User Experience Improvement Program

Basic Customer Demographics

VMware is constantly trying to improve the user experience of our products. You can

help us in this effort by agreeing to send product usage statistics. This data is EI
completely anonymous, and is restricted to product usage metrics. For more details

about it visit the YMware user experience improvement web page by dicking the *..."

button,

|:| Participate anonymausly in the user experience improvement program

Eeleh: your orgamzation mdustry bpe: |

Edlect lom=fion of your organizaton’s headguarker: |

Seled: approymate number of emplovess: |
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i VMware Horizon View Connection Server

Ready to Install the Program
The wizard is ready to begin installation.

VMware Horizon View Connection Server will be installed in:
C:\Program Files\VMware\VMware View\Server\

Click Install to begin the installation or Cancel to exit the wizard.

<ood [ ][ o]

a8 SUS FiNish g, o JulS coas a5 ke

) ViMware Horizon & Connection Server -

Installer Completed

The installer has successfully installed YMware Horizon &
Connection Server, Click Finish to exit the wizard.

HNext Steps:

Show the readme file

VMware Horlzon™6 WARNIMNG: Due to limited memory available on this system, the
. Harizon & components have been configured to use reduced
Connection resources. Please refer to the Horizon & View administration

guides to determine how to correctly size this system.

Server

Product version: 6.2.0-3005368 x54 < Badk Cancel
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S b u»)oTj 03,5 3L 1, 095 adle 5,90 ,5 550 Horizon JPELRER VI VWL S VIRSRL WA sl
http://Server_IP/admin

Iy ael o ol a5 aylo ;L5 Leis o ,ls Adobe Flash player 1331 0 5 4 5L d > sl View JgusS a5 Ll ;)

DS b g a6 55005 (59

vmware

View Administrator requires Adobe Flash 10.1 or higher. Click below to download

j Get ADOBE
Flash Player

Sy 2 908,5 3)lg |, PASSWOrd ¢ USErNAME 595 oo Hbles 5 amio )5 950 10 IP 50,5 515 9 YU Ul e (b 5l e
A5 SsTLogin

VMware Horizon™6

s View Administrator

Password:

Domain:

™ Remember user name

Log In

D e o3l Liules HOrizon View Administrator Lol a=ao
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VMware Horizon 6 View Administrator About | Help | Logout (administrator)

Updated 2/10/2016 10:43 PM l%’ Licensing and Usage

Sessions 0
Problem vCenter VMs 0
Problem RDS Hosts 0
Events 0 oMo
System Health [l @ (=]

11 1 0

Licensing Custorner Experience Program

[a— (e s

A Mo valid license present for View Manager. Click Edit Send anonymous data to VMware  Off

to add a valid license. L
Inventory Geographic Location:

Business Vertical:
&2 Dashboard

&% Users and Groups Number of Employees:
» Catalog

¥ Resources

Usage
g Farms d

1 Machines
Persistent Disks
* Monitoring

» Policies

[Rmt Highest Count ] [R@eet Named Users c:uunt] ]

Session Mode Current Highest

. . . Total Concurrent Co
¥ View Configuration

Servers Total Named Users
Product Licensing and Usag Detailed Connection
Global Settings Total Remote

Registered Machines Active - full virtuz
Administrators Active - linkad clc
ThinApp Configuration
Cloud Pod Architecture

Ewvent Configuration

Active - other ma

Active - applicatic

o003 b g 0,5 sl 1, Product Licensing and Usage ... s View Configuration ..o cuw g5 |
DS OK s 900,57 0l e i S5 (Edit license aus's

License serial number:

el 0 s HOrizon View 457
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Licensing and Usage

Licensing

| Edit License... |

License Key: AT QP - O - RO - -P 3ELS
License expiration: Never

Desktop license: Enabled

Application Remoting license: Enabled

View Composer license: Enabled
Usage Model: Named User
-y plasl 4y Connection Server oas
Event View gl wslis sbxl
Lis Microsoft SQL Server Management Studio (Administrator)

File Edit Wiew Debug Tools Window Help
{31l (S el | NewQuey (B ER | 4 B9 -6 - B-5 @]
Object Explorer > X

Conneci~ & 3 g °F E "

= (b SOL (SOL Server 11.0.5058 -

S| Datbases
3 Security Mew Database...
[ Server Ob
[ Replicatio
C3 AlwaysOr Restore Database...

Attach...

[ Managerr Restore Files and Filegroups...
[ Integratic
ﬁ% 50L Serve

Deploy Data-tier Application...
Import Data-tier Application...

Start PowerShell

Reports

Refresh

38
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d New Database
Selecta page l ) 3
) Script - Hel
% General ; = llj ?
[ Options
_’%ﬁ Filegroups Database name: |E\rer|t‘u"|ew
Owner: <default:
Database files:

Logical Mame File Type  Filegroup
Evert\View Rows ... PRIMARY

EventView |... Log Mot Applicable

Object Explorer * 1 X
Connect~ & J @ “F ] "

= [ SOL (SOL Server 11.0.5058 -
+ [ Databases

Initial Size (ME)

- [ Security
e | Logins
+ [ Server Mew Login...
% [ Crede Filter ,
+ [ Crypte
+ [ Audits Start PowerShell
# [ Server Reports »
+ [ Server Ob
+ [ Replicatio Refresh

+

[ Always0n High Availabi
[ Management

+

[ Integration Services Catz
[ SOL Server Agent

+

+

Autogrowth / Maxsize
{ By 1 MB, Unlimited
By 10 percent, Unlimited
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5 Script = [ Help

Login name: |E\rent\|"|ew

O Windows authertication
(®) SQL Server authentication

Password: |oooooooo

Corffirm password: |oooooooo
|| Specity old password

Old paﬁwon:l: |
[] Enforce password policy
= s e

[ User must change password at next login
) Mapped to certficate |
O Mapped to asymmetric key |
[ Map to Credertial |
Mapped Credentials

Connection

Server:
SaL

Connection:
.!ﬁ View connection properties

Progress

Ready Defaut databass: EventView
<default>

Defautt language:

Select a page ESSW'&H**‘

Server role is used to grant server-wide security privileges to a user.

Server roles:

[ bulkadmin
[] dbcreator

[ diskadmin
[] processadmin
[v] public

[] securityadmin
[] serveradmin
[ setupadmin

Connection

Server:
saL

Connection:

&7 View connection properties

Progress
Ready

ok || Cancel
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5 Scipt ~ [ Help

Users mapped to this login:
Map Database

i EvertView

| master
model
msdb
tempdb
ViewComposer

[] Guest account enabled for: EventView

Database role membership for: EventView

[] db_accessadmin
Server: [] db_backupoperator
saL [] db_datareader
Connection: [] db_datawriter

[] db_ddladmin

db_d ataread
37 View connection properties E db dmat:::t;

Connection

Progress
Ready

User DSN | System DSN | Filg DSN | Drivers | Tracing | Connection Pooling | About |

System Data Sources:
Mame Platform  Driver Add.

Remove

Corfigurs...

An ODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users on this machine, including NT services.
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= ODBC Data Source Administrator (64-bit)

User DSN | System DSN | File DS I Drivers I Tracing I Connection Pooling I About |

System Data Sources:

Mame Platform  Driver

Create New Data Source

Select a driver for which you want to set up a data source.

Name Version Com)

| SQL Server 6.03.9600.17415  Micre
EE] Ve e AN 2011.110.5058.00 Micn

e

e indicated data provider.
icES.

Create a New Data Source to SQL Server

This wizard will help you create an ODBC data source that

“qﬁb SGL Server.

y:

you can uge to connect to

What name do you want to use to refer to the data source?

§6°|: SEI:VEI 201

Name: | EventView

How do you want to describe the data source?

Description: |

Which SQL Server do you want to connect to?

Server: | SQL.TECHNET24 local

Fiish || MNet> | | Cancel | | Hep
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How should SQL Server verfy the authenticity of the login ID7?

)

&y
ﬁ&erverznu

) With Integrated Windows authentication.

5PN (Dptionall |

®WH153L53veraﬂ1aﬁcaﬁonushgalogtha1dpasswmdmaedbyﬁ1e
LIgEr,

Login ID: |EventView

Password: |iii"|u|-
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[#] Change the default database to:

P | Evert\iew
Hhmu Wlirmar server:

SPN far mimar server (Optional):

[ ] Attach database filename:

[#] Use ANS| quoted identifiers.
[#] Use ANSI nulls, paddings and wamings.
Application intent:
| READWRITE
[] Mutti-subnet failover.

[] Change the language of SAL Server system messages to:

| English

[] Use strong encryption for data
[] Perform translation for character data
[] Use regional settings when outputting cumrency, numbers, dates and times.

[] Save long running queries to the log file:

|C:\Users\ADMINI™1\AppData\Local\ Temp\QUERY| |

Long query time (milliseconds): |3'D'DD'|]

[] Log ODBC driver statistics to the log fils:
|C:\Users\ADMINI™1\AppData\Local\ Temp\S TATS | | Browse.
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Anew ODBC data source will be created with the following configuration:

Microsoft SQL Server Native Cliert Version 11.00.5058

Data Source Name: EventView

Data Source Description:

Server: sgltechnet24 Jocal

Use Integrated Securty: No

Database: ViewComposer

Language: (Default)

Data Encryption: Mo

Trust Server Certificate: No

Multiple Active Result Sets{MARS): No
Mirror Server:

Translate Character Data: Yes

Log Long Running Queries: No

Log Driver Statistics: No

lUse Regional Settings: No

Use ANSI Quoted |dentffiers: Yes

Uzse AMSI Null, Paddings and Wamings: Yes

|| ok || cancel

Test Results

Microsoft SQL Server Native Client Viersion 11.00.5058
Running connectivity tests. ..

Attempting connection

Connection established

Verfying option settings

Disconnecting from server

TESTS COMPLETED SUCCESSFULLY!

oS oo s3,%e View CoONNection Server 4 |, (EventView) ous azslo umlys ;55|
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VMware Horizon 6 View Administrator

Updated 2/11/2016 10:27 AM g2 Event Configuration
Sessions o]
Problem vCenter VMs 0 Event Database
Problem RDS Hosts 0 —————
T Edit... |
Events 0 /s 0 —
System Health [l @ (=] No database has been defined, events will not be
1 1 1 0 recorded. Click 'Edit..." to specify a database server.
Inventory Evant Settings
£2 Dashboard Event settings cannot_ be configured until a database
server has been specified.
ﬁ Users and Groups
» Catalog
¥ Resources
[ Farms
51 Machines

2 Persistent Disks

> Monitoring

» Policies

¥ View Configuration
Servers
Froduct Licensing and Usage
Global Settings
Registered Machines
Administrators
ThinApp Configuration
Cloud Pod Architecture

Event Configuration
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VMware Horizon 6 View Administrator

Updated 2/11/2016 10:27 AM

Sessions
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Problem vCenter VMs

&
0
0
Problem RDS Hosts 0
Events © oo
System Health
Y = 1. IE On Edit Event Database

Database server:
Inventory Ev

Soyse yeetS Dygo 50 elawl 00l 0391 115 Jodz 10 Wgdes b cead w18 (b o a8 55 3 00 kS
Sls plosl Firewall o 1) cledass cpl ciws &0 o Bl cuad 5l o (2,8 i

&% Dashboard EVEl patabase type:
sen)|
a Users and Groups ]
» Catalog Port:

¥ Resources

[

Database name:
Farms

{51 Machines User name:
Persistent Disks
» Monitoring Password:
» Policies

Confirm password:
¥ View Configuration

Servers Table prefix:
Product Licensing and Usage
Global Settings

Registered Machines
Administrators

192.168.1.15

Microsoft SQL Server |«

1433

EventView

EventView

I oK I| cancel |

ThinApp Configuration
Cloud Pod Architecture

Event Configuration

Replica Server , View Connection Server ;L o,50 slocs g

fowo o <9 g
View Desktop Connection Server 4001 JMS
Replica Connection Servers Connection Server 4100 JMSIR
Admin Browser Connection Server 80 HTTP
Admin Browser Connection Server 443 HTTPS
Client 1 Connection Server 4172 (P'I?(?Fl’Pand UDP)
Client 2 Connection Server 443 HTTPS
Connection Server 1 View Desktop Subnet 4172 PColP
Connection Server 2 View Desktop Subnet 3389 RDP
Connection Server Virtual Center Server 443 HTTPS
Connection Server Virtual Center Server 80 HTTP
Connection Server zczgéslciemngegsif)rver 18443 |HTTPS
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View Security Server ;L s s sla &9

fowo o ©9 g
Client Security Server 443 |HTTPS
Client Security Server 80 HTTP
Client 1 Security Server 4172 (P'I?(?IIDPand UDP)
Security Serverl View Desktop Subnet 4172 E‘I(':C(:)ILPan d UDP)
Security Server View Desktop Subnet 3389 |RDP
Security Server View Desktop 9427 |MMR
Security Server Connection Server 8009 |AJP13
Security Server Connection Server 4001 |IMS
Security Server Connection Server 4002 |IMS
Security Server Connection Server 500 |IPSec (UDP)
Security Server Connection Server 4500 |NAT-T ISAKMP (UDP)
Connection Server Security Server 500 |IPSec (UDP)
Connection Server Security Server 4500 [NAT-T ISAKMP (UDP)
Security Server Connection Server ESP (IP Protocol 50)

View Agent ;Ls 5,90 slo &4

T waio <9 JSNg 9
Client View Desktop 3389 |RDP
Connection Server2 View Desktop 3389 |RDP
Client View Desktop 4172 |PColP(TCP and UDP)
Connection Serverl View Desktop 4172 |PColP(TCP and UDP)
Security Serverl View Desktop 4172  |PColP(TCP and UDP)
Client View Desktop 32111 |USB Redirection
Client zlgiﬁ)\;\gi[c):lsgr?ﬁ/ ) 42966 |HP RGS
Client View Desktop 9427 |MMR
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View Desktop

Connection Server

4001

JMS

View Desktop

Connection Server

4002

JMS
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P yle> s

Desktop pools slx| — s Pool g1yl - View Connection 4, Jlasl
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: View Connection 4, Jlas!

5 3950 5% oyl 39 35l -
Https://Server/admin
0 &5 oS samlin |, Certificate , v obig sl (S View CoNNection « sg,5 sl 51

85 ool |y ol lgs
: View Connection « vCenter :,sqes a8lsl -

View Configuration ->Servers > vCenter Servers Tab > Add -> Server Address -
Username (Administrator@vsphere.local or Domain\User) ->Password —>Port: 443
—->Next =>Finish

: View Connection « View Composer :joges aslsl -

View Configuration - Servers 2> vCenter Servers Tab > Add - Complete vCenter
Server information->View Composer co-installed with vCenter Server / Standalone View
Composer Server

1S sLas (Reclaim) sls yl

g ail Gl b s s cud b ol Sae Sl sibre Sl LS Jl o )5 a5 oK
oz Olg oo FEClamation sl eolatwl b casl axils 5L5 cavass adgl slad 4 Cans (5 i glad
el plin Sloglais (23 Cews Sl g5z Ul o iz 0,8 J5SS 0 505 el s | S
285 1) ilome QLSws (53,5 b 9

View Configuration - Servers >vCenter Servers Tab—>Add - Complete vCenter and
Composer information - Reclaim VM disk spase

165w 053 (Accelerator) w s
g oo 0olatul (5le slo (pdile slo ools 0,5 Cache .y
View Configuration ->Servers >vCenter Servers Tab > Add - Complete vCenter and

Composer information > Enable View Storage Accelerator - Default host cache size
(between 100 MB and 2048 MB)

: View Composer s vCenter s ,. sly ol oo Sldes Codgamae

T Olondiis

VIEW [, a5 losen slginlys o slaws zSTas | Max concurrent vCenter provisioning

- ) operations
&S oolel wilgs e CONnection P

Ve ioy8 Sl lode
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sl ciriig ) olejen POWET &lles slass 2Sla> | Max concurrent power operations

(o ¢ g SUSPENd

B 1028 e sl

rebalance. recompose . refresh cllee olass iSlas> Ma_x concurrent Vie_w Composer
VieW Ly a5 linked clone s s, » 45 maintenance operations

Db oa plml 05l o o o COMpoSeEr

WWoio,8 G lade

linked <G 55, 2 lopod Bi> 5 sl slass 2STas | Max concurrent View Composer
provisioning operations

Db o Copow View Composer lawgs as clone

A oioyd S Hlade

CONCUITENE Csls oo 00,5 Uas j9,0 4 yotie 45 09 0L (5,08 4 (g5lne (Slgaiinn (ol YU ylo; 5]
Sl a5 O 4 00 Il o, oS |, power operation

: Thumbprint 5,3,

g0 Jld |, thumbprint L3 5,k 5l el oo ol (o CA L alal, o IS S
View Administrator ->View Certificate = The thumbprint match: Accept

16 5lre o lSws sl

O il oo s5lme sl 51 PO0L vz b S sl 4y 5l (silme criile o3 b G sl (sl
ol 4 0ges ol Jelrsiuas SO 5l oo az8 5 snapshot L image <G ss, 5l ol oo |y b uislo
Sl glre uiile oo 1 (59, 5 g 48,5 IMage s WINOWS 7 s Jule it G 51 45 & 900
Ol 4 99 ol 51 Gy 0,8 Canys (6028 sloasliy (61, POON wizr by S )l (oo (o 095 (o0

la POOI ¢ly!

:Desktop pools
0,5 NN ngs = ul.s_i..m) L Lg)'l.?v..o Q.M.JLA £ A

52 Technet24r
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Dy oo ol cunl 39250 VCENLET o 45 SNAPSHOL L 5503 G (59, 51 1 Suilogsl

Orile 5 (58 (6o sealS g g e VEBNTEN Lawsgs a5 (g5l slo (udle 5| Sloegacno : (Jwsd
Sgdus L=l VEENLEr 5| 2 g5l yiws (59, &5 (55l sl

zé,5 clone ()T g5, 515 9,5 slml lme eile S (g8 (o0 (s D50 4

i RDS cll> o Js oyl olas] )5 G s oile yo  ciws b Slegsl 2> 0 :RDS
oS ool esle 5l algs oo )lS

: desktop pools bl

13,5 sl Remote Desktop Pool g oo ) aace 4w

RDS hostl, desktop PC aile (SG 58 e S5 -

Dyl oo o poe VECENTEI g s lawgs g ails |18 ESXI (59, a5 55lxe fuile S -

S olazs |, View Agent 5 oo | > VCeNter 51 e s5le yiws (59, 45 (55lme orile G -

Sime Sl ol g, g (oo g solainl GLSws aie olsie 4 VSPhere sl uile 5 31
ol Sl eosd 0dg POOL (gl sl 457 (55lme sl (pdle slaw S Tas g Joluo 0oais b g 0500 55055 |,
3> 5l o 1y 09z ge mlie LS (Jg 05ed ol bl (5,58 oolatul sl SIS slaremote desktop
2,5 ool

1Dgad By y25 5 ) Dy 90 4 OleS oo |y (gilme s il

:Dedicated assignment pools

Slgi go )5 05l g0 0)ly QLS ploa 4 )L jo g alls [ 095 Ll (gilme GLSws o )8 2
StateFul G (55, ! 50 aled 0,33 00lo b oS ol dnliys g 00505 (55l (cated | 095 LSy
54 oo o] desktop image

[Floating assignment pools

S8 oo il o) aile WS W SY 505y S o USer aw g ewil ailo VM SO 5T ig, ol o
o ALlo Ioazme (gam eolaiul jo 5 LA MLlS Sl jeb ay coslaiul Jb o 5l o (g5l G o
S ey Jlasl )b o 5l g 00558 Sl 0T 595 2t (Sl 5 Slalats WisT gum a5 (S (nl @ 055
500l 0,5 cnl gilme slo pile 5l iy S slaws a5 Sl sl hgy () 00,5 o adsl
Db o a5l Stateless desktop image <G g, o

:Application pools
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Ao oo 51,8 e ol 5l 1 IS Lasl o 1) (60 )5 sl asli

: Application pools b l;e

A4l g s (60,58 sl aslip 4 aSl jo ol e 5l S s -

5 Thin Client (b LJ cels aneidgn slo ol sl o )5 slealKiws 5 Slaitiy elfiws i -
2,8 b 1y gl sd b ol (oo s ()l 51 (529,5 b )5 4 0l (o0 (Sl &z s S5 -
(SIS Dlenlais g jlunsly dlea 5l 0l )5 sla SS9, Lol o 5 S e 203092 S poke BB -
O s (535 45 Cenl g5 (555 L)1l 3 5 el plomil LB Gl @y Lailas 5, 4 5 Gl
3y 9 5 pee yebo 4 (Tl Lad e sl ools 5 lajlsl o 5 iils 18 s ay ol e (5l ] il -
oalo

Dgd (oo Ay GralS 4 e Ay Copde g & e ledoly il )l Seme At e ralS -

: Desktop pools sl!
b ol Jole pins ol ot a0 (55lme (ile S el g ags « desKtop pools bl g1y a3 sl
omled oo ol VEENTET 1o (g5lne (pdle SO 5 drg) b 005 )18 (s5lme sla il (555!

vCenter Server =2 File > New - Virtual Machine = New Virtual Machine Wizard
Edit the virtual machine settings before 4. ;5 Gl s ol |, Custom a5

o Sye s §lp a5 0550 Jole e 1ISO LB 5 (61581 Coew Glelass aslsl o g cOMpletion
ail e V++++ 55, Power-on Boot Delay .l 3 Connect on power on ol e « 35,5
il prble i3l gz bl bl el o

S9y 2SS L g g, 1) el POWET ON Gl g (g5lome (uitle (595 p ol ) SIS

pmled oo J 1) ()] g cead Jgoro j5b 4 1) Jule i CONSOlE
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59009 55k oolel - WINAOWS 7 & 8 (o3Les age - View Agent coas - ylage Jule it (55l o0kl
Composer L. deploy 4 3,5 clone s,
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(ol Jole i) 93,5 oo i (g3l eile (55 2 45 hole s (5L 0Ll

o3l i

Oletes Jole plncs caad 9 (55lme (iilo oloml -

,99 oy sl LliSws sl Active Directory oot -

@ oliSus olp,l8 Hos adlol 5l ludol cg> AD o remote desktop USers o sgase 09,5 slowl -
&me opisle remote deskitop USers o5, oo oyl )l

&5lme (iile 53, 5 TEMOtE desKIOP sla gy (05 Jlad 5l liebo] -

Olege Jole piasw (59, » (@dministrative rights) co pow Gei> ousls 5 laeds! -

: os ogus
€ Jole s Sl g (3lme (il 59, 2 Sl SIS € (3lme eile 505 (53,
VMware Tools &,/ cuas
Salen sl VMware time synchronization ;i soliw! ¢ Windows time service o, Jlaé e .Y
ESXil sjlme cble oo (53l
5L 9,90 sla,li8l o oo g wgpg ol « Update « Service pack s Y
Swled cuai View Agent 5l os |, .Net Framework :aiss ¢

- Power options - Turn off the display = Never
- Control Panel > System -> Advanced System Settings > Performance Settings = ..

L5 Visual Effects « Adjust for best performance

A 5o ol 5l eolawl & yg0 0 PIOXY Server o.las .0
0505 Laseive DHCP 1 T 2l jo ogei asie by 5 IP aass) aSs LU slo S5 eulas #
(DNS 5,

QS e glaiin s OlSws 1 169.254.X.X la wyol 51 VIEW wasSs %
58l oy aS Parent gilxe yuiile (rueld) 0uS aials gae 590 of ) sl CLSws slp 1) g5lxe il Y
(2l s S5l lo piile fpsls b aiSwe osliiul o] 51 View Composer
Sile il b L5 (gl 490 of ) Gl 4 o3l>1 (sl Firewall oo A

VMware cols ;s 05230 VMware Optimization Tool Sél s 1l 5l ol oo xS

oS oolaiwl oo
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:View Agent coxs
rolisSws solawl g1, Windows Server Jale giwew (55 solel

ks i

Sl Jol> luedl Remote desktop service Role o405 cuas 5l -

el ol SP1 s « Windows Server 2008 s ,.5,15 4 & g0 4o -

Restart after o, » I, Firewall g, c windows Server 2012 R2 ¢ ,.5,IS & &,90 40 -

[g, ) VMware Horizon™

1) View Agent

Swles oulas Failures

sslme oeile 59, 2 View Agent ez

Agreement License 5 cuas L6 sl -

VMware Product Installation

=’ Preparing VMware Horizon View Agent’for installation...
=

10
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i VMware Horizon View Agent | x|

Welcome to the Installation Wizard for
VMware Horizon View Agent

The installation wizard will install VMware Horizon View Agent
on your computer, To continue, dick Mext.

VMware Horlzon™ Copyright © 1998-2015 VMware, Inc, All rights reserved, This
. product is protected by U.S. and international copyright and
View Agent intellectual property laws., VMware products are covered by

one or more patents listed at
http: ffwww . vmware . comfgo/patents.

EIPCalE

Product version: 6.2.0-3005627 x54 < Back | Mext = || Cancel |

i VMware Horizon View Agent

License Agreement

Please read the following license agreement carefully.

VMWARE END USER LICENSE AGREEMENT ~

PLEASE NOTE THAT THE TERMS OF THIS END USER
LICENSE AGREEMENT SHALL GOVERN YOUR USE OF
THE SOFTWARE, REGARDLESS OF ANY TERMS THAT
MAY APPEAR DURING THE INSTALLATION OF THE
SOFTWARE.

(®) I accept the terms in the license agreement

() I do not accept the terms in the license agreement

= Back ” Mext = | | Cancel
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RDS Role 45 _oitwws 59, ) Install VMware Horizon View Agent in ‘desktop mode’ -

Desktop 05 Configuration
The following information is used to configure the View Desktop feature

The Remote Desktop Session Host role is not installed on this operating system. To configure the
Agent in RDS mode restart the installer after configuring the Remote Desktop Session Host raole,

Please check the box to continue installing YMware Horizon View Agent in 'desktop mode',

[#] Install YMware Horizon View Agent in 'desktop mode'

IPV4 s -

Metwork protocol configuration
Select the communication protocol

Specify the protocol to be used to configure this View Agent instance:

iz agent will be configured to choose the IPv4 protocol for establishing
all connections.
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Accept destination folder -

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description
VMware Horizon View Agent

My
Serial Port Redirection
Scanner Redirection
1JSE Redirection

HTML Access
Real-Time Audio-Video This feature requires 165MB on your hard
Client Drive Redirect drive. It has 7 of 11 subfeatures selected.
Ient Lirve kedirection The subfeatures require 41ME on your
Virtual Printing hard drive.

Install to:

C:\Program Files\WMware \WMware ViewAgenty

Hep || space || <Bak ] | [ conce

plo Cag, &,50 ,o remote desktop support s ;Ludles -

Remote Desktop Protocol Configuration
The following information is used to configure the Remote Desktop feature

VMware Horizon View Agent requires the Remote Desktop support to be turned on. Firewall
exceptions will be added for the RDP port #3382 and the View Framework channel £32111,
What would you like to do?

(®) Enable the Remote Desktop capability on this computer

() Do not enable the Remote Desktop capability on this computer
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View Connection Server « Lg, o FOQDN L P ;0,5 s )ls -

Register with Horizon View Connection Server
Enter the Horizon View Connection Server that this machine will connect to.

Enter the server name of a Horizon View Connection Server (standard or replica instance) and
administrator login credentials to register this machine with the View Connection Server.

ConnServer, TECHMET 24, local (hostname or IP address)

Authentication: (@) authenticate as the currently logged on user
() Spedfy administrator credentials

Username:

| (Domainyser)

Password:

Ready to Install the Program
The wizard is ready to begin installation.

YMware Horizon View Agent will be installed in:

C:'Program Files\WMware\WMware View\Agent

Click Install to begin the installation or Cancel to exit the wizard,

MNOTE: The RDS role is not enabled on this OS5, YMware Horizon View Agent will support
only single desktop connections.
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i VMware Horizon View Agent

Installer Completed

VMware Horizon™

View Agent

EIPCalE

The wizard was interrupted before VWMware Horizon View Agent
could be completely installed.

Your system has not been modified. To install this program at a
later time, please run the installation again.

Click Finish to exit the wizard,

Cancel

o restart 4 5Ls v USB Redirection ol o go o :auss %

T

d

4 a5 Imaging 4 Scanning skalKws o SRedirect

oy SlSws (59, 45 (5 9b 4 siiws Jaie Client yie..
il oolaiwl LB wo (60,05 4ol g 590

Scanner Redirection

e yobb 4 a5 USB (sla olSiws a5 o yiwd ol )15 &
A oo |y aiiis Jais

USB Redirection

5hoslaiwl b 1, L View desktop « Jlas! ojl>! oyl 5 5
2o sHTML Access

HTML Access

linked-clone (s, oo |,>1 65> View Agent «
1y ailaads slow! (g3l fwile (pead Lawgs a5 ladesktop

REV- ) <

View Composer Agent

4 a5 Webcam 4 Audio skalKiws oo SRedirect

oy SLSws (59, 45 (5,9 & diws Jaie Client g

Real-TimeAudio-Video
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il oolaiul LB oo 90

9y 99250 Syt p dan b (285 Cuy p ojll S 4

Virtual Printing

o;l>1 VRealize Operations for View « a5 SleMb
3,5l 0 ol 8 02s o |y Lo View desktop ,, ol

vRealize Operations Desktop Agent

O b (o SlSws 595 )8 blgn o0,5Synch
Ol aS g5k 4 ye00ly Lilégy

View Persona

o Lkl p 4 digd (o0 0y QLS 4 o) 5o

Aol aslo

Management

oley yo ) wiadign O 5L cugr >l ool )5 @
a3 o PCoOIP Display S, 5l ool

PColP Smartcard

A8 oo mly8 590 ol ) QLS (59, 1) silre slowe a0

VMware Audio

: Windows 7 & 8 g5l aiyy
IPV6 ¢;Ludlad,.c -

Ol pss CSlpe s a5 ondas poged Jlad e sl TSULT (5w File System Utility )l oolaca! -

( fsutil behavior set disablelastaccess 1:5ie) .o,ls (oo a5 1) (o yiws 3550 b1 (59, 00l Jlos!

0x000000be(190) a4 (125 s 49) & sz, ,o TiMeoutValue REG_DWORD |laie s -
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\Disk

ol b s e sla task s windows customer experience yo,S igels -

Lol 0,57 (rgy e S3lme ble 9 ule it (30,57 (gal5 -
system restore . Registery backup . diagnostic policy service . update . defrag s ;LuJles ¢ -

feed synchronize. windows defender .

: Composer L.y deploy 4 -x:8,5 clone sy 905 3l ool
IPConfig/release jyiws lawgs 09590 IP 0,5 SL -

S JEs S 53l (5lme ble -

o sl oedle 59, O 0ab (S 5l 9l e Pagefile.sys o5 S, -
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8,5 51 s powercfg.exe/hibernate off giws 51 eslaiw! L Hibernation a5 0,5 Jlad e -

searching windows update for device drives 4. ;5 . (Parent) ol ;e oisle 5 Snapshot

led Jlad e |,

Wy ordle plod b adsl 5lme oaiile (59, VAP 438 33,5 Jlaé 5ue VSphere Client ;s -

scheduled maintenancec L 5,5 Jlad ¢ -

Mo

Schtasks.exe /change /disable /tn"\Microsoft\Windows\AppxDeploymentClient\Prestaged

app cleanup"

58,5 clone i LS gilre fuile (0,8 gels -

Ak ezme gDl eans -

13405 osliiwl 1 )l5 & e VM 5100l S Silegs! anass gz ol oo 2 Jgo

s

d

1oLl 4 parass ogau Sl

ools Laads nile S 4 )5 e dedicated assignment o
ST oo 2dlyo 1) edle les Jb e g 0nd

Solee eile l0gin » o o, 15 floating assignment s
AL e cdl e

User Assignment

@ Gd D)z ]y eble po Sl oo 2Bl b an S cal S
i 42 995 sl 50 G JUd Sjge 0wl pavass )8
Lo ool oo (fs Ol (o0 9 958 (o0 00ls Laras )5 4y etle

Sl ple]

Enable Automatic Assignment

o Sopde POOI jo 1y g5lme slo isle a5 sl VCeNtEr L]
&S

vCenter Server

View administrator ,s |, ;)1 a5 pool &l 8,5 4 pasie ol

Desktop pool ID

oasiine ol cpl ST 008 o ools isles oyl )18 4 a5 51 poOl 6l
Dy oo 00ld Lialed 1S 4 pOOI ID 545

Display Name

S oo e |y il sl (eedle 4y gy Sleps S

Access Group

Sl b wles S eolaul ol )15 s, Floating assignment ;1 3

0 40 Q\gSGAQT)W ooLé.‘:...;l}\mO#SLo O, Sb ol s el

Delete machine after log off

Technet24r
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.-5).3

el 5145 oy 3 (1 Canndy mble Sy SlalsiS (nsd
oyl g imlos JSTgy gl o3 oolaiwl (gjle

Desktop pool settings

b il ;550 50 VM provisioning slas |1,SS 51 .5 ol> sl

Stop provisioning on error

Silbee sl pile (gl o laslin] el ol

Virtual machine naming

S Sy Ay o piile (gl pb ol

Specify names manually

88 4 pasie o)led SO egdle 4 Wigdan SO (50Kl 09l (] 5o
PCO1, PC02, PC0O3 y oooile D9 o0 oolazwl U""“’L° gL LS‘):’

Naming pattern

Omile dlaws iSlas i (g IS pU o laslinl 5l eolaiwl & yg0 o
pool ,s

Maximum number of machines

Number of spare machines

A auales as-le POOL sl ylej yo a5 slo uile slows JSlo

Minimum number of machine
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